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Read Chapter 1 for safety 
and general instructions.

Install the Companion XL.
See Chapter 2

Choose a 
connection type:

Windows 98 
Computer

See Chapter 3

Windows NT 
Computer

See Chapter 4

Windows 2000 
Computer

See Chapter 5

Windows XP 
Computer

See Chapter 6

Installation Flowchart

Operate the Companion XL.
See Chapter 8
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CombiFlash® Companion® XL
Installation Guide

Section 1 Introduction

1.1  Documentation Overview
This installation guide provides:

• Safety information

• Unpacking instructions

• Installation instructions, including —

• Direct connection to a computer

• Placing the Companion XL on a network

The installation procedure will vary according to the 
intended instrument control method. To determine which 
steps are required, refer to the Installation Flowchart on 
page iii of this guide.

Once you have connected to the Companion XL, you may refer 
to PeakTrak’s on-line help for operating instructions. 

The documentation CD that accompanies the Companion XL 
contains this guide and the Foxy 200 Instruction Manual in 
Adobe Acrobat PDF format, and the PeakTrak® On-line Help.
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1.2  Product Overview
The Teledyne Isco CombiFlash® Companion® XL flash 
chromatography system gives you high-productivity 
automation, programmable gradients, and full-spectrum UV 
detection and peak separation. The Companion XL is a high 
capacity system that purifies samples up to 150 grams. Yet, its 
small size makes the system well suited for operation in 
chemical hoods. 

Important
Indoor use only.

WARNING
Avoid hazardous practices! If you use this instrument in any 
way not specified in this manual, the protection provided by 
the instrument may be impaired; this may increase your risk 
of injury.

Control of the Companion XL is through a simple to use 
interface. This interface can be accessed through a Windows 
computer directly connected to the instrument, or through a 
standard computer network. The Companion XL can also be 
configured with an optional touch-panel display. In all, you 
have the flexibility to program, operate, and monitor the 
Companion XL at the instrument, from a computer in the lab, 
or from remote locations. 

The Companion XL uses Teledyne Isco RediSep® columns. 
Compatible sizes range from 120 to 1500 grams, which can 
accept sample sizes from 0.1 to 150 grams. 

Applications include purification of organic compounds for 
drug discovery, as well as research in agrochemicals, 
petrochemicals, natural products, polymers, and catalysts.
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Figure 1-1  CombiFlash Companion XL with Foxy 200 Fraction 
Collector (shown with optional touch-panel display)
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1.3  Operating Overview
The Companion XL may be controlled by a Windows® 
computer or by the optional touch-panel display. The 
Companion XL may be connected to the computer in two 
different ways, direct or network. 

Computers running Windows operating system may be 
directly connected to the Companion XL using a cross-over 
cable between Ethernet ports. Computers running Windows 
operating system may also connect to the Companion XL 
through a network using TCP/IP protocol. 

Note
Teledyne Isco recommends that you obtain assistance from your 
IT department before attempting direct or network connections to 
a Windows computer.

1.3.1  Control Priorities

The Companion XL supports multiple connections. However, 
only one computer connection may control the instrument. If 
you are using the optional touch-screen display, it always 
controls the Companion XL, regardless of the other 
connections. With network operation, the first connection to 
the Companion XL becomes the controlling device. The second 
user logged in will only be able to view the operation.

1.3.2  File Storage

To support operation from a variety of direct and network 
connections, the software and all support files are stored 
within the Companion XL. This ensures that your separation 
or purification methods and run history files can be viewed 
from any connection. 

A login password prevents unauthorized access to the 
Companion XL from remote connections.
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1.4  Specifications

Table 1-1 Specificationsa,b

a. All specifications are preliminary and subject to change.
b. Specifications do not include the fraction collector. For these

specifications, refer to the Foxy 200 Instruction Manual on the
documentation CD. 

Dimensions Height: 64 cm (25")
Width: 37 cm (14.5")
Depth: 40 cm (15.75")

Weight 23.5 kg (51.7 lbs)

Power Options Input voltage range from 100 to 240 VAC, 2.0 
Amps maximum

Line Frequency 50/60 Hz

Ambient Temperature 20 to 40°C (maximum temperature must be 
at least 10°C below the boiling point of the 
solvent)

Humidity (when 
connected to power)

95% relative humidity maximum at 20 to 
40°C

Flow Rate Range 50 to 450 ml/min

Flow Rate Accuracy ±5%

Pressure Limit 50 psi

Pressure Accuracy ±5 psi

Peak Detection Modes Slope or threshold

UV Spectrum 200 to 360 nm

Wavelength Accuracy ±5 nm

Flow Cell Pathlength 0.1 mm, ±25%

Tube Fill Accuracy ±[.6 + (1.3 × flow rate) ÷ 60] ml
(for all tubes except bottles)

Pollution Degree 2

Electrical Safety per EN 61010-1

Installation Category II

Maximum Altitude 2000 meters
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1.5  Controls, Indicators, and Features
Figures 1-2 and 1-3 illustrate the controls on the CombiFlash 
Companion XL. Refer to the Foxy® 200 instruction manual for 
complete information on the fraction collector. This manual is 
available in PDF format on the documentation CD.

Figure 1-2  CombiFlash Companion XL (Front)
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1. Status LEDs – The POWER LED lights when power is 
applied to the system. The READY LED illuminates after 
the Companion XL completes its startup routine and is 
ready for operation.

2. Disconnect Device (Power Switch) – Located on side of 
unit. 1 = ON, 0 = OFF 

3. Solid Sample Cartridge Retainer – Supports a solid 
sample cartridge when installed. This spring-loaded 
retainer raises so that the cartridge can be inserted, then 
lowers to apply downward force on the Solid Sample 
Cartridge Cap, holding it in place. The system monitors the 
position of the retainer to determine if a cartridge is 
installed. 

4. Solid Sample Cartridge Cap – Connects to top of solid 
sample cartridge. Three sizes are available to match the 
size of cartridge. The system ships with the 25 and 70g 
caps. The optional 300g cap and cartridges may be ordered 
as accessories. 

5. Solid Sample Cartridge – Holds solid samples. Three 
sizes are available to match the size of cap (item 4). 

6. Sample Injection port – Liquid samples are injected into 
this port, typically with a syringe. Solid sample cartridges 
connect to this port. When this port is included in the fluid 
path under software control, the sample is routed to the 
column. 

7. Upper Column Mount – Secures top of RediSep column 
and directs solvent into the column. The mount adjusts to 
height of column. The position of this mount is read by the 
Companion XL to determine the column size. There are 
two sizes of fittings. The 120 and 330g columns use the 
smaller fitting; 750 and 1500g columns use the larger 
fitting. 

8. RediSep Column – A 330g RediSep normal phase flash 
chromatography column is shown. Different column sizes 
and media are available for use on the Companion XL. 

9. Lower Column Mount – Secures bottom of column. 
Fluids from the column outlet flow through this port to the 
internal optical detector. There are two sizes of holes. The 
120 and 330g columns use the smaller hole; 750 and 1500g 
columns use the larger hole.
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Figure 1-3  CombiFlash Companion XL (Back)

10.Top Shelf Drain – Spills on the top shelf are drained 
through this tubing.

11.Foxy 200 Control Port – Serial port for connection to 
Foxy 200 Fraction Collector. 

12.Ethernet Port – 10/100-base T Ethernet connection. Used 
for direct connection to a computer using the cross-over 
cable, or for a network connection using a standard cable. 

13.USB Port – unsupported at this time. 
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14.Foxy 200 Fluid Port – Routes fluid output to the fraction 
collector. 

15.Cooling Fan – Ventilates and cools the Companion XL.

16.Rear Panel Knob – Service personnel only. Used to open 
the hinged rear panel to access internal components. 

17.Ground – Optional equipment grounding post for 
user-customized applications.

18.A Solvent Inlet – Receives the A solvent liquid.

19.B Solvent Inlet – Receives the B solvent liquid.

20.Mains Power – Connects to AC line voltage.

1.6  Safety
Before installing, operating, or maintaining this equipment, it 
is imperative that all hazards and preventive measures are 
fully understood. While specific hazards may vary according to 
location and application, take heed in the following general 
warnings:

WARNING
Liquids associated with this instrument may be classified as 
carcinogenic, biohazard, flammable, or radioactive. Should 
these liquids be used, it is highly recommended that this 
application be accomplished in an isolated environment 
designed for these types of materials in accordance with 
federal, state, and local regulatory laws, and in compliance 
with your company’s chemical/hygiene plan in the event of a 
spill. 

WARNING
Avoid hazardous practices! If you use this instrument in any 
way not specified in this manual, the protection provided by 
the instrument may be impaired.
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WARNING
If you are using flammable solvents or chemicals with this 
system, vapor concentration levels may exceed the maximum 
exposure levels as recommended by OSHA Guide 1910.1000. 
To reduce those levels to a safe exposure, Teledyne Isco 
recommends that you place the system in a laboratory hood 
designed for the purpose of ventilation. This hood should be 
constructed and operated in accordance with federal, state, 
and local regulations. In the event of a solvent or chemical spill, 
your organization should have a plan to deal with these 
mishaps. In all cases, use good laboratory practices and 
standard safety procedures. 

1.6.1  Hazard Severity Levels

This manual applies Hazard Severity Levels to the safety 
alerts. These three levels are described in the sample alerts 
below.

CAUTION
Cautions identify a potential hazard, which if not avoided, may 
result in minor or moderate injury. This category can also warn you 
of unsafe practices, or conditions that may cause property 
damage.

WARNING
Warnings identify a potentially hazardous condition, which if 
not avoided, could result in death or serious injury.

DANGER
DANGER – limited to the most extreme situations to identify 
an imminent hazard, which if not avoided, will result in 
death or serious injury.
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1.6.2  Hazard Symbols

The equipment and this manual use symbols used to warn of 
hazards. The symbols are explained in Table 1-2.

Table 1-2 Hazard Symbols

Warnings and Cautions

The exclamation point within the triangle is a warning 
sign alerting you of important instructions in the 
instrument’s technical reference manual.

The lightning flash and arrowhead within the triangle is a 
warning sign alerting you of “dangerous voltage” inside 
the product.

Symboles de sécurité

Ce symbole signale l’existence d’instructions 
importantes relatives au produit dans ce manuel.

Ce symbole signale la présence d’un danger 
d’électocution.

Warnungen und Vorsichtshinweise

Das Ausrufezeichen in Dreieck ist ein Warnzeichen, das 
Sie darauf aufmerksam macht, daß wichtige 
Anleitungen zu diesem Handbuch gehören.

Der gepfeilte Blitz im Dreieck ist ein Warnzeichen, das 
Sei vor “gefährlichen Spannungen” im Inneren des 
Produkts warnt.

Advertencias y Precauciones

Esta señal le advierte sobre la importancia de las 
instrucciones del manual que acompañan a este 
producto.

Esta señal alerta sobre la presencia de alto voltaje en el 
interior del producto.
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1.7  For Additional Information
Technical assistance for the CombiFlash Companion XL can 
be obtained from:

Teledyne Isco, Inc.
4700 Superior St.
Lincoln NE 68504

Phone:  (800) 228-4373 or (402) 464-0231
Fax:  (402) 465-3001
E-mail:  Iscoservice@Teledyne.com

mailto:service@isco.com
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Section 2 Installation

This section provides instructions for unpacking the 
Companion XL and preparing it to be connected to a computer 
or network.

2.1  Unpacking the Unit
The CombiFlash Companion XL is shipped in multiple 
cartons. Carefully unpack the shipment and inspect the 
contents to verify receipt of all components against the 
packing list. If there is any damage to the shipping carton or 
any components, contact the shipping agent and Teledyne Isco 
(or its authorized representative) immediately. 

WARNING
If there is any evidence that the system has been damaged in 
shipping, do not plug it into the power line. Contact Teledyne 
Isco or its authorized representative for advice.

Compare the contents of the boxes with the enclosed packing 
slip. If there are any shortages, contact Teledyne Isco 
immediately.

2.2  Assemble the Foxy 200
The Foxy 200 Fraction Collector must be assembled before 
use. Refer to the instructions supplied with the Foxy 200. 
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2.3  Instrument Location
The CombiFlash Companion XL has a footprint of about 1500 
square centimeters (230 in2) of bench space (37 cm W × 40 cm 
D, 14.5" W × 15.75" D). Ensure that the Companion XL has at 
least 3 cm (1.25") of air space behind it for ventilation. 
Additional space may be required for the solvent supply and 
waste containers. 

CAUTION
Ensure there is at least 10 cm (4 inches) of air space on its right 
side so that the disconnect device (power switch) may be easily 
accessed in an emergency.

Space is required for fraction collection. A Foxy® 200 Fraction 
Collector has a footprint of about 2300 square centimeters 
(360 in2) of bench space (38 cm W × 61 cm D, 15" W × 24" D). 
The Companion XL system includes one Foxy 200 Fraction 
Collector. If additional Foxy 200s were ordered to extend the 
collection capacity, more space is required. Fraction collectors 
may be stacked on shelves to conserve bench space. The 
Companion XL can control up to four Foxy 200 Fraction 
Collectors. 

CAUTION
Ensure there are no obstructions on the left side of the fraction 
collector that would impede movement of the arm. Obstructions 
could misdirect fluids or damage the fraction collector. 

Note
If ordering additional Foxy 200 fraction collectors for the system, 
be sure to specify that they are intended for use with a 
CombiFlash Companion XL. Fraction collectors must be 
factory-configured for use with the CombiFlash Companion XL.

Refer to Table 1-1 for environmental conditions and power 
requirements. 
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2.4  Electrical Connections 

2.4.1  Foxy 200 Control Cable

Locate the serial cable, P/N 480-7996-00, in the accessory kit. 
Attach this cable’s 9-pin connector to the Foxy 200 Control 
Port on the rear panel of the Companion XL. Attach the other 
end to the 25-pin connector labeled “SERIAL” on the back of 
the Foxy 200. 

If additional Foxy 200 Fraction Collectors are to be used with 
the system, connect the additional fraction collectors using the 
supplied “Y” cables. 

2.4.2  Connect Power

WARNING
Mains power must meet the voltage, frequency, and amperage 
requirements listed on the instrument’s serial number label. 

Use the supplied IEC power cords to connect the 
Companion XL and Foxy 200 to mains power. 

2.5  Connect Solvent Tubing
Attach the Solvent A and B lines to the fittings on the back of 
the Companion XL. Place the weighted ends of the solvent 
tubing in their respective solvent containers. 

The solvent ports at the back of the Companion XL can be 
rotated so that tubing can be routed easily. To rotate the 
fitting, loosen the Swagelok® nut, rotate the elbow fitting to 
the desired position, then re-tighten the nut. 

Note
To prevent damage or premature wear to the pump and internal 
valves, clean solvent should be used. The solvent should not 
contain any dissolved solids. 

WARNING
Risk of fire or equipment damage. Failure to connect Foxy 200 
tubing may allow organic solvents to pool in unsafe areas, 
creating a potential for dangerous levels of flammable vapors. 
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Attach tubing to the Foxy 200 port on the back of the 
Companion XL and route it to the inlet port on the Foxy 200’s 
Diverter Valve. Attach tubing to the Diverter Valve’s Waste 
port and route it to a suitable collection container. 

If additional Foxy 200 Fraction Collectors are to be used with 
the system, plumb the fraction collector liquid connections 
according the instructions in the connection package.

2.6  Connect Drain Tubing

WARNING
Risk of fire or equipment damage. Failure to connect drains 
may allow organic solvents to pool in unsafe areas, creating a 
potential for dangerous levels of flammable vapors. 

There are two drains on the Companion XL that are used to 
manage spilled fluids. One drain is the located on the side of 
each Foxy 200 tray (Figure 2-1). This drain carries away fluid 
that spills in the tray beneath the tube rack. Attach tubing 
and route it to a suitable waste fluid collection container.

Figure 2-1  Foxy 200 Drain Tubing
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The other drain is located on the top shelf of the 
Companion XL. Route the tubing attached to the bottom of 
this drain (Figure 2-2) to a suitable waste fluid collection 
container. This will carry away spills on the top shelf.

Note
It may be necessary to extend the length of tubing from both 
locations. If so, splice the tubing with user-supplied tubing. The 
user-supplied tubing should have an inside diameter no smaller 
than the existing drain tubing, and must be compatible with the 
solvent being pumped. Route this extension tubing to the waste 
collection vessel.

Figure 2-2  Top Shelf Drain
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Section 3 Direct Connection with
Windows 98

This section provides instructions for establishing direct 
communications with the Companion XL from a computer 
with Windows 98 operating system.

3.1  Windows 98 Computer Requirements
Minimum System Requirements:

• 266 MHz Pentium processor

• 32 MB RAM

• Ethernet Port

• TCP/IP services installed

• VGA or better graphics, minimum screen area of 
800 × 600 pixels

• Microsoft Windows 98, Second Edition

• Microsoft Internet Explorer 5.5 or later

3.2  Establishing a Direct Connection
Sections 3.2.1 through 3.2.3 configure the computer so that it 
can communicate with the Companion XL. After completing 
the steps, the computer and Companion XL may be operated 
as a stand-alone system, or the direct connection may be used 
to configure the Companion XL so that it can be added to a 
network (see section 7).

3.2.1  Configure the Computer’s Local Area Network

1. From the Windows Start button, select “Settings>Control 
Panel” to view the control panels.

2. Locate the “Network” icon and open this control panel. 
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3. Highlight the “TCP/IP” item in the list, and click on the 
“Properties” button. The TCP/IP Properties Window will 
open (Figure 3-2). Select the IP Address tab. 

Note
The following steps change the local area connection settings. If 
the computer must be restored to its original network 
configuration, record the present Internet Protocol (TCP/IP) 
settings now. 

4. Click the “Specify an IP address” option. 

5. Enter the IP address “192.168.1.200”. 

6. Enter the default Subnet Mask “255.255.255.0.” 

7. Click the OK button to close the Internet Protocol 
properties window. Then, click the OK button to close the 
Local Area Connection properties window. 

Figure 3-1  Network Control Panel Window
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Figure 3-2  TCP/IP Properties Window

3.2.2  Configure the Computer’s Internet Browser Options

1. Start Internet Explorer. 

2. From the File menu, select “Work Offline.”

3. From the Internet Explorer window, select the 
“Tools>Internet Options...” menu command. 

4. Select the Security tab on the Internet Options window. 
Refer to Figure 3-3. 

5. Highlight the Internet icon. 

6. Click the “Custom Level” button. The Security Settings 
options will appear. 

7. In the Reset Custom Settings box, select “Medium” from 
the pull-down list and click the Reset button. 

8. In the Settings list, locate the ActiveX controls and 
plug-ins and select the following options (See Figure 3-4):

• Download signed ActiveX controls – Enable

• Run ActiveX controls and plug-ins – Enable

9. Click the OK button to close the Security settings options. 
If you are asked “Are you sure...?”, click Yes and continue.
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10.On the Internet Options window, click Apply to change the 
settings.

11.On the Internet Options window, select the Connections 
tab. 

a. Click the LAN Settings... button. 

b. Ensure that the “Use a Proxy Server” check box is not 
selected. 

Figure 3-3  Default Internet Security Options

Figure 3-4  ActiveX Security Settings
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Note
The “Use a Proxy Server” check box must be cleared to connect to 
the Companion XL.

c. Click OK to close the LAN settings window. 

12.Click OK to close the window.

13.Shut down the computer.

3.2.3  Start Direct Communications

1. Connect the Windows 98 computer to the Companion XL 
using the blue cross-over cable (P/N 480-6545-02). 

2. Turn the Companion XL’s power switch to ON. Wait for the 
second green light (Ready), and then start the computer. 

3. Start Internet Explorer and type in the address 
“http://192.168.1.51/login”. The browser will display the 
PeakTrak Login screen. 

Note
The PeakTrak Login screen indicates that the direct connection is 
working. 

4. Enter the login password for the Companion XL. The 
Companion XL is shipped with the default password of 
“companion” (all lower-case). Click the submit button. 

Note
The default password may be changed after you have established 
the connection. Refer to the Companion XL’s on-line help 
documentation after you have completed the connection. 

5. The Companion XL begins to download the necessary files 
for operation. 

6. When the download is complete, the Companion XL will 
display the PeakTrak Main window. The title bar will read 
“Companion Powered by PeakTrak.”



CombiFlash® Companion® XL Installation Guide

3-6

Note
Some versions of the Windows operating system will require the 
computer to be restarted before new ActiveX plug-ins can run. If 
you are notified that the computer must be restarted, you may do 
so now. After the computer restarts, complete steps 3 and 4 again 
to reach the PeakTrak Main window. 

The Companion XL and the computer are now configured as a 
stand-alone system. Refer to PeakTrak’s on-line help for 
operating instructions. Abbreviated instructions can be found 
in Section 8 of this guide. 

If you want to add the Companion XL to the network, proceed 
with Section 7 of this installation guide. 
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Section 4 Direct Connection with
Windows NT4

This section provides instructions for establishing 
communications with the Companion XL from a computer 
with Windows NT4 operating system.

4.1  Windows NT4 Computer Requirements
Minimum System Requirements:

• 266 MHz Pentium processor

• 32 MB RAM

• Ethernet Port

• TCP/IP services installed

• VGA or better graphics, minimum screen area of 
800 × 600 pixels

• Microsoft Windows NT 4.0

• Microsoft Internet Explorer 5.5 or later

Note
The procedures described in this section will require a user 
account on the PC with administrator privileges. If your user 
account does not have administrator privileges, contact your IT 
department before proceeding.

4.2  Establishing a Direct Connection
Sections 4.2.1 through 4.2.3 configure the computer so that it 
can directly communicate with the Companion XL. After 
completing the steps, the computer and Companion XL may be 
operated as a stand-alone system, or the direct connection may 
be used to configure the Companion XL so that it can be added 
to a network (see Section 7). 
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4.2.1  Configure the Computer’s Local Area Network

1. From the Windows Start button, select “Settings>Control 
Panel” to view the control panels.

2. Locate the “Network” icon and open this control panel. 

3. View the Protocols tab of the Network window and 
highlight the “TCP/IP Protocol” item in the list. Then, click 
on the “Properties” button. Refer to Figure 4-1. 

Note
The following steps change the local area connection settings. If 
the computer must be restored to its original network 
configuration, record the present Internet Protocol (TCP/IP) 
settings now. 

4. Click the “Specify an IP address” option. 

5. Enter the IP address “192.168.1.200”. 

6. Enter the default Subnet Mask “255.255.255.0.” 

7. Click the OK button to close the TCP/IP Properties 
properties window. Then, click the OK button to close the 
Network properties window. 

Figure 4-1  Network Protocols
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Figure 4-2  TCP/IP Properties

4.2.2  Configure the Computer’s Internet Browser Options

1. Start Internet Explorer. 

2. From the File menu, select “Work Offline.”

3. From the Internet Explorer window, select the 
“Tools>Internet Options...” menu command. 

4. Select the Security tab on the Internet Options window 
(see Figure 4-3). 

5. Highlight the Internet icon. 

6. Click the “Custom Level” button. The Security Settings 
options will appear. 

7. In the Reset Custom Settings box, select “Medium” from 
the pull-down list and click the Reset button. 

8. In the Settings list, locate the ActiveX controls and 
plug-ins and select the following options (See Figure 4-4):

• Download signed ActiveX controls – Enable

• Run ActiveX controls and plug-ins – Enable

9. Click the OK button to close the Security settings options. 
If you are asked “Are you sure...?”, click Yes and continue.
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10.On the Internet Options window, click Apply to change the 
settings.

11.On the Internet Options window, select the Connections 
tab. 

a. Click the LAN Settings... button. 

b. Ensure that the “Use a Proxy Server” check box is not 
selected. 

Figure 4-3  Default Internet Security Options

Figure 4-4  ActiveX Security Settings
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Note
The “Use a Proxy Server” check box must be cleared to connect to 
the Companion XL.

c. Click OK to close the LAN settings window. 

12.Click OK to close the window.

13.Shut down the computer.

4.2.3  Start Direct Communications

1. Connect the Windows NT computer to the Companion XL 
using the blue cross-over cable (P/N 480-6545-02). 

2. Turn the Companion XL’s power switch to ON. Wait for the 
second green light (Ready), and then start the computer. 

3. Log in to the computer using an account with 
administrator privileges.

Note
Logging in with administrator privileges is necessary to register 
PeakTrak software components (during step 6) on the computer 
so that all user accounts on that computer will be able to connect 
to the Companion XL.

4. Start Internet Explorer and type in the address 
“http://192.168.1.51/login”. The browser will display the 
PeakTrak Login screen. 

Note
The PeakTrak Login screen indicates that the direct connection is 
working. 

5. Enter the login password for the Companion XL. The 
Companion XL is shipped with the default password of 
“companion” (all lower-case). Click the submit button. 

Note
The default password may be changed after you have established 
the connection. Refer to the Companion XL’s Help documentation 
after you have completed the connection. 
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6. The Companion XL begins to download the necessary files 
for operation. 

7. When the download is complete, the Companion XL will 
display the PeakTrak Main window. The title bar will read 
“Companion Powered by PeakTrak.”

Note
Some versions of Windows operating system will require the 
computer to be restarted before new ActiveX plug-ins can run. If 
you are notified that the computer must be restarted, you may do 
so now. After the computer restarts, complete steps 4 and 5 again 
to reach the PeakTrak Main window. 

The Companion XL and the computer are now configured as a 
stand-alone system. Refer to PeakTrak’s on-line help for 
operating instructions. Abbreviated instructions can be found 
in Section 8 of this guide. 

If you want to add the Companion XL to the network, proceed 
with Section 7 of this installation guide. 
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Section 5 Direct Connection with
Windows 2000

This section provides instructions for establishing 
communications with the Companion XL from a computer 
with Windows 2000 operating system.

5.1  Windows 2000 Computer Requirements
Minimum System Requirements:

• 266 MHz Pentium processor

• 64 MB RAM

• Ethernet Port

• TCP/IP services installed

• VGA or better graphics, minimum screen area of 
800 × 600 pixels

• Microsoft Windows 2000, Service Pack 3

• Microsoft Internet Explorer 5.5 or later

Note
The procedures described in this section will require a user 
account on the PC with Administrator privileges. If your user 
account does not have administrator privileges, contact your IT 
department before proceeding.

5.2  Establishing a Direct Connection
Sections 5.2.1 through 5.2.3 configure the computer so that it 
can communicate with the Companion XL. After completing 
the steps, the computer and Companion XL may be operated 
as a stand-alone system, or the direct connection may be used 
to configure the Companion XL so that it can be added to a 
network (see Section 7).
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5.2.1  Configure the Computer’s Local Area Network

1. From the Windows Start button, select “Settings>Control 
Panel” to view the control panels.

2. Locate the “Network and Dial-up Connections” icon and 
open this control panel. 

3. Highlight the “Local Area Connection” icon. View the 
properties by right-clicking and selecting “Properties.” The 
Local Area Connection Properties Window will open 
(Figure 5-1).

4. Highlight the “Internet Protocol (TCP/IP)” item in the list, 
and click on the “Properties” button. The Internet Protocol 
Properties Window will open (Figure 5-2). 

Note
The following steps change the local area connection settings. If 
the computer must be restored to its original network 
configuration, record the present Internet Protocol (TCP/IP) 
settings now. 

5. Click the “Use the following IP address” option. 

6. Enter the IP address “192.168.1.200”. 

Figure 5-1  Local Area Connection Properties Window
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Figure 5-2  Internet Protocol Properties Window

7. Enter the default Subnet Mask “255.255.255.0.” 

8. Click the OK button to close the Internet Protocol 
properties window. Then, click the OK button to close the 
Local Area Connection properties window. 

5.2.2  Configure the Computer’s Internet Browser Options

1. Start Internet Explorer. 

2. From the File menu, select “Work Offline.”

3. From the Internet Explorer window, select the 
“Tools>Internet Options...” menu command. 

4. Select the Security tab on the Internet Options window. 
Refer to Figure 5-3. 

5. Highlight the Internet icon. 
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Figure 5-3  Default Internet Security Options

6. Click the “Custom Level” button. The Security Settings 
options will appear. 

7. In the Reset Custom Settings box, select “Medium” from 
the pull-down list and click the Reset button. 

8. In the Settings list, locate the ActiveX controls and 
plug-ins and select the following options (See Figure 5-4):

• Download signed ActiveX controls – Enable

• Run ActiveX controls and plug-ins – Enable

9. Click the OK button to close the Security settings options. 
If you are asked “Are you sure...?”, click Yes and continue.

10.On the Internet Options window, click Apply to change the 
settings.

11.On the Internet Options window, select the Connections 
tab. 

a. Click the LAN Settings... button. 

b. Ensure that the “Use a Proxy Server” check box is not 
selected. 
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Figure 5-4  ActiveX Security Settings

Note
The “Use a Proxy Server” check box must be cleared to connect to 
the Companion XL.

c. Click OK to close the LAN settings window. 

12.Click OK to close the window.

13.Shut down the computer.

5.2.3  Start Direct Communications

1. Connect the Windows 2000 computer to the Companion XL 
using the blue cross-over cable (P/N 480-6545-02). 

2. Turn the Companion XL’s power switch to ON. Wait for the 
second green light (Ready), and then start the computer. 

3. Log in to the computer using an account with 
administrator privileges.

Note
Logging in with administrator privileges is necessary to register 
PeakTrak software components (during step 6) on the computer 
so that all user accounts on that computer will be able to connect 
to the Companion XL.
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4. Start Internet Explorer and type in the address 
“http://192.168.1.51/login”. The browser will display the 
PeakTrak Login screen. 

Note
The PeakTrak Login screen indicates that the direct connection is 
working. 

5. Enter the login password for the Companion XL. The 
Companion XL is shipped with the default password of 
“companion” (all lower-case). Click the submit button. 

Note
The default password may be changed after you have established 
the connection. Refer to the Companion XL’s Help documentation 
after you have completed the connection. 

6. The Companion XL begins to download the necessary files 
for operation. 

7. When the download is complete, the Companion XL will 
display the PeakTrak Main window. The title bar will read 
“Companion Powered by PeakTrak.”

Note
Some versions of Windows operating system will require the 
computer to be restarted before new ActiveX plug-ins can run. If 
you are notified that the computer must be restarted, you may do 
so now. After the computer restarts, complete steps 4 and 5 again 
to reach the PeakTrak Main window. 

The Companion XL and the computer are now configured as a 
stand-alone system. Refer to PeakTrak’s on-line help for 
operating instructions. Abbreviated instructions can be found 
in Section 8 of this guide. 

If you want to add the Companion XL to the network, proceed 
with Section 7 of this installation guide. 
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Section 6 Direct Connection with
Windows XP

This section provides instructions for establishing direct 
communications with the CombiFlash Companion XL from a 
computer with Windows XP operating system.

6.1  Windows XP Computer Requirements
Minimum System Requirements:

• 266 MHz Pentium processor

• 64 MB RAM

• Ethernet Port

• TCP/IP services installed

• SVGA or better graphics, minimum screen area of 
800 × 600 pixels

• Microsoft Windows XP Professional

• Microsoft Internet Explorer 5.5 or later

Note
The procedures described in this section will require a user 
account on the PC with Administrator privileges. If your user 
account does not have administrator privileges, contact your IT 
department before proceeding.

6.2  Establishing a Direct Connection
Sections 6.2.1 through 6.2.3 configure the computer so that it 
can communicate with the Companion XL. After completing 
the steps, the computer and Companion XL may be operated 
as a stand-alone system, or the direct connection may be used 
to configure the Companion XL so that it can be added to a 
network (see Section 7). 
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6.2.1  Configure the Computer’s Local Area Network

1. From the Windows Start button, open the Control Panel.

2. Locate the Network Connection icon and open this control 
panel. 

3. Highlight the “LAN or High-speed Internet Connection” 
icon. Select the “Change settings of this connection” option, 
or right-click and select “Properties.” Refer to Figure 6-1. 

Figure 6-1  LAN or High-speed Internet Connection

Figure 6-2  Local Area Connection Properties
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Figure 6-3  Alternate Configuration Settings

4. Highlight the “Internet Protocol (TCP/IP)” item in the list, 
and click on the “Properties” button. Refer to Figure 6-2.

5. Select the Alternate Configuration tab. Click the “User 
Configured” option. See Figure 6-3.

6. Enter the IP address “192.168.1.200”. 

7. Enter the Subnet Mask. Enter the default Subnet Mask, 
“255.255.255.0.” 

8. Click the OK button to close the Internet Protocol 
properties window. Click the Close button to close the Local 
Area Connection properties window. 

6.2.2  Configure the Computer’s Internet Browser Options

Note
Attention Microsoft Internet Explorer 7 Users:
Before connecting to the Companion XL, run the preinstaller tool. 
Refer to instruction sheet 60-5232-099.

1. Start Internet Explorer. 

2. From the File menu, select “Work Offline.”
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Figure 6-4  Default Internet Security Settings

3. From the Internet Explorer window, select the 
“Tools>Internet Options...” menu command. 

4. Select the Security tab on the Internet Options window. 

5. Highlight the Internet icon. 

6. Click the “Custom Level” button. The Security Settings 
options will appear. 

7. In the Reset Custom Settings box, select “Medium” from 
the pull-down list and click the Reset button. 

8. In the Settings list, locate the ActiveX controls and 
plug-ins and select the following options (See Figure 6-4):

• Download signed ActiveX controls – Enable

• Run ActiveX controls and plug-ins – Enable

9. Click the OK button to close the Security settings options. 
If you are asked “Are you sure...?”, click Yes and continue.

10.On the Internet Options window, click Apply to change the 
settings.
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Figure 6-5  ActiveX Security Settings

11.On the Internet Options window, select the Connections 
tab. 

a. Click the LAN Settings... button. 

b. Ensure that the “Use a Proxy Server” check box is not 
selected. 

Note
The “Use a Proxy Server” check box must be cleared to connect to 
the Companion XL.

c. Click OK to close the LAN settings window. 

12.Click OK to close the window.

13.Shut down the computer.

6.2.3  Start Direct Communications

1. Connect the Windows XP computer to the Companion XL 
using the blue cross-over cable (P/N 480-6545-02). 

2. Turn the Companion XL’s power switch to ON. Wait for the 
second green light (Ready), and then start the computer. 

3. Log in to the computer using an account with 
administrator privileges.
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Note
Logging in with administrator privileges is necessary to register 
PeakTrak software components (during step 6) on the computer 
so that all user accounts on that computer will be able to connect 
to the Companion XL.

4. Start Internet Explorer and type in the address 
“http://192.168.1.51/login”. The browser will display the 
PeakTrak Login screen. 

Note
The PeakTrak Login screen indicates that the direct connection is 
working. 

5. Enter the login password for the Companion XL. The 
Companion XL is shipped with the default password of 
“companion” (all lower-case). Click the submit button. 

Note
The default password may be changed after you have established 
the connection. Refer to the Companion XL’s Help documentation 
after you have completed the connection. 

6. The Companion XL begins to download the necessary files 
for operation. 

7. When the download is complete, the Companion XL will 
display the PeakTrak Main window. The title bar will read 
“Companion Powered by PeakTrak.”

The Companion XL and the computer are now configured as a 
stand-alone system. Refer to PeakTrak’s on-line help for 
operating instructions. Abbreviated instructions can be found 
in Section 8 of this guide. 

If you want to add the Companion XL to the network, proceed 
with Section 7 of this installation guide. 
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Section 7 Networking

This section provides instructions for adding the CombiFlash 
Companion XL to a local area network and connecting to it 
from a Windows computer.

Note
The procedures described in this section will require a user 
account on the PC with Administrator privileges. These 
procedures will also require assistance from your network 
administrator. Contact your IT department before proceeding.

7.1  Establish a Direct Connection
Before proceeding with configuring the Companion XL for the 
local area network, you must be directly communicating with 
the Companion XL using one of the methods described in 
sections 3 through 6, according to the operating system of the 
selected computer.

7.2  Configuring the Companion XL for Networking
Sections 7.2.1 and 7.2.2 provide instructions for adding the 
Companion XL to the local area network. After it is recognized 
by the network, you may connect to the Companion XL using 
the instructions in section 7.2.3.

7.2.1  Assign the Companion XL’s Network Address

1. If open, close PeakTrak by selecting the File>Exit menu 
command.

2. Start Internet Explorer and browse for the address 
“http://192.168.1.51/config”.

The Configuration screen allows you to set:

• Enter IP Address – Use this to change the 
Companion XL’s IP address to one within the local 
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area network. The IP address is assigned by your 
network administrator.

• Enter Netmask – Use this to change the 
Companion XL’s Netmask setting. The Netmask is 
assigned by your network administrator.

• Enter Gateway Address – Use this to set a gateway 
for the Companion XL. The gateway is assigned by 
your network administrator. 

Alternatively, you can select the “Use DHCP Only” check 
box. Before using DHCP, confirm that the network can 
automatically handle Linux address requests. Additionally, 
the network administrator must be able to manually asso-
ciate the MAC address in the DNS server table. 

If using DHCP, it is important to: 

• configure the DHCP lease as “infinite.”

• associate the Companion XL’s MAC Address with a 
unique name on the network. 

Note
A label on the Companion XL’s back panel lists the instrument’s 
MAC Address. 

For example, when using DHCP the Companion XL could 
be assigned the name “My_Companion.” User’s would then 
access the instrument through the address 
“http://My_Companion.”

3. After entering the settings that meet the requirements of 
your network, click the Update button to apply the 
settings. 

4. The screen advances and displays the old and new 
addresses. Record this information. 
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7.2.2  Install Network Cable

1. Turn the Companion XL’s power switch to OFF. 

2. Disconnect the blue crossover cable from the 
Companion XL. (This cable may only be used for direct 
connections.)

3. Connect the Companion XL to the local area network using 
the beige Ethernet cable (P/N 480-6545-01). This is a 10 
foot long Category 5 Ethernet cable, terminated with RJ-45 
connectors.

Note
The computer used for direct connection to the Companion XL 
may be returned to its original configuration at this time. 

7.2.3  Establish Communications through the Local Area Network

1. Turn the Companion XL’s power switch to ON. Wait for the 
second green light (Ready) to illuminate. 

2. From any network computer within the same domain and 
workgroup (consult your network administrator), log in to 
computer using an account with administrator privileges. 

Note
Logging in with administrator privileges is necessary to register 
PeakTrak software components (during step 14) on the local 
computer so that all user accounts on that computer will be able to 
connect to the Companion XL.

Note
The computer must meet the minimum requirements specified in 
Table 7-1. 

Note
Attention Microsoft Internet Explorer 7 Users:
Before connecting to the Companion XL, run the preinstaller tool. 
Refer to instruction sheet 60-5232-099.
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3. Start Internet Explorer. 

4. From the Internet Explorer window, select the 
“Tools>Internet Options...” menu command. 

5. Select the Security tab on the Internet Options window. 

6. Highlight the Internet icon. 

7. Drag the slider to the Medium Security Level. Click the 
Apply button. 

8. Click the “Custom Level” button. The Security Settings 
options will appear. See Figure 7-1.

9. Locate the ActiveX controls and plug-ins and select the 
following options (refer to Figure 7-2):

• Download signed ActiveX controls – Enable

• Run ActiveX controls and plug-ins – Enable

10.Click the OK button to close the Security settings options.

11.On the Internet Options window, apply the setting and 
click OK to close the window. 

Table 7-1 Minimum Computer Requirements

Compatible 
Operating Systems

Windows 98
Windows NT4
Windows 2000 with Service Pack 3
Windows XP Professional

Processor Pentium class, 266 MHz minimum

Memory Must meet Microsoft’s minimum 
recommended RAM for the selected 
operating system.

Display SVGA, 800 x 600 pixels, minimum

Internet Browser Microsoft Internet Explorer 5.5 or later
ActiveX Enabled

Network Protocol TCP/IP installed

Network Connection Ethernet 10/100 Base-T



Section 7  Networking

7-5

Figure 7-1  Default Internet Security Options

Figure 7-2  ActiveX Security Settings



CombiFlash® Companion® XL Installation Guide

7-6

12.In Internet Explorer, type in the Companion XL’s address 
assigned by your network administrator 
“http://______________/login”. The browser will display the 
PeakTrak login screen. 

Note
The PeakTrak Login screen indicates that the Companion XL has 
been successfully added to the local area network.

13.Enter the login password for the Companion XL. 

14.The Companion XL begins to download the necessary files 
for operation.

15.When the download is complete, the Companion XL will 
display the PeakTrak Main window. The title bar will read 
“Companion Powered by PeakTrak.”

Note
Some versions of Windows operating system will require the 
computer to be restarted before new ActiveX plug-ins can run. If 
you are notified that the computer must be restarted, you may do 
so now. After the computer restarts, complete steps 11 and 12 
again to reach the PeakTrak Main window.
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Section 8 Operation

This section provides abbreviated operating instructions for 
the Companion XL. For complete instructions, refer to 
PeakTrak’s on-line help. 

8.1  Installing a Collection Rack
Before beginning a run, you must load collection tubes on the 
Foxy 200. To do so:

1. Select racks. Your system was shipped with two racks that 
hold 25 mm diameter tubes (P/N 68-2137-045). Several 
racks are available:

• Foxy Rack, 16 mm diameter tubes (100), P/N 
68-2137-043

• Foxy Rack, 18 mm diameter tubes (72), P/N 
68-2137-044

• Foxy Rack, 28 mm diameter scintillation vials (36), 
P/N 68-2137-046

• Foxy microfunnel tray to channel drops with 12 or 
13 mm tube racks. Pkg of 10. 
P/N 68-2137-013

• Foxy 200 Prep Rack (26 Halar funnels that allow 
unlimited samples sizes). 
P/N 68-2137-095

Note
The Foxy 200 will hold two tube/vial racks, two microfunnel trays, 
or one prep rack. Additionally, eighteen 400 ml bottles, 500 ml 
bottles, or 150 ml beakers can be used. Refer to the Foxy 200 
Instruction Manual for correct bottle placement on the drip tray. 

2. Insert the tubes or vials into the racks. 
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3. Place the racks on the Foxy 200 (Figure 8-1). 

4. If this is the first time the system has been used, or if a 
different rack has been selected, verify the configuration 
setting. Do this by selecting the “Tools>Configuration” 
PeakTrak’s menu command. Ensure the PeakTrak 
Hardware Configuration window setting matches the 
selected rack.

Figure 8-1  Loading the racks

8.2  Prime the Solvent Lines
Before proceeding, verify that the solvent, waste, and drain 
lines have been connected according to Section 2.5. 

1. Start PeakTrak by logging in to the Companion XL.

2. From PeakTrak’s Main Window, select the “Tools>Auto 
prime” menu command. 

3. Ensure that a priming tube is inserted between the upper 
and lower column mounts. The priming tube must be 
connected to the smaller fittings used for 120–330g 
columns. 
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Note
A priming tube is a piece of tubing with Luer connectors that attach 
between the column mounts, bypassing the column. The 
Companion XL is shipped with a priming tube installed. 

4. Click the “Ok” button to start priming the system. 

The Companion XL primes pump B, then pump A. 

5. When finished, PeakTrak notifies you that the “AutoPrime” 
process has completed successfully.” Click the “Ok” button 
to close the window. 

8.3  Loading a RediSep Column
To load a RediSep column:

1. Select a RediSep column. Generally, the column is selected 
based on the size of the sample. Refer to Table 8-1 for 
recommended column sizes. 

2. After selecting a column, note its flow direction. The flow 
direction on RediSep columns is the same direction the 
label is read. When installed, the inlet will be mounted 
upward.

3. Select the correct column fittings. There are two sets of 
fittings. Columns ranging from 120g to 330g use the 
smaller Luer fittings (see Figure 8-2). Larger columns use 
the larger diameter fittings. 

4. Raise the top column mount and insert the RediSep column 
into the upper fitting for the selected column size. 

5. Slowly release the upper column mount while aligning the 
lower column fitting. Give the column a slight twist to seat 
the column in its upper and lower fittings.
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Figure 8-2  Large and small column fittings

Table 8-1 Recommended Normal Phase 
RediSep Columns

Sample Size RediSep Column

0.12 – 12g Samples Use the RediSep 120 g column. RediSep 
120g Normal Phase columns can be ordered 
in packages of 10. 
(Teledyne Isco Part Number 68-2203-024)

0.33 – 33g Samples Use the RediSep 330 g column. RediSep 
330g Normal Phase columns can be ordered 
in packages of 4. 
(Teledyne Isco Part Number 68-2203-058)

0.75 – 75g Samples Use the RediSep 750g column. RediSep 
750g Normal Phase columns can be ordered 
in packages of 4. 
(Teledyne Isco Part Number 68-2203-275)

1.5 – 150g Samples Use the RediSep 1500g column. RediSep 
1500g Normal Phase columns can be 
ordered in packages of 3. 
(Teledyne Isco Part Number 68-2203-277)

750 – 1500g
Columns

120 – 330g
Columns
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Figure 8-3  Loading a 330g RediSep Column

Note
PeakTrak will automatically detect the column size. The detected 
column size is displayed on the PeakTrak Main and PeakTrak 
Advanced Program windows. 
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8.4  Prepare the Sample 
Before starting the run, the sample should be prepared for 
introduction to the column. The Companion XL supports three 
methods that introduce the sample: liquid sample injection, 
solid sample cartridges, and loading sample directly onto the 
column.

8.4.1  Liquid Sample Injection

Before starting a separation using a liquid injection, the 
Liquid Injection accessory kit (60-5244-050) must be installed 
on the system. 

1. Remove the Solid Sample Load Cartridge cap and its 
tubing from the bulkhead fitting on the front of the 
Companion XL. 

2. Screw the Swagelok plug (209-0165-21) from the accessory 
kit onto the bulkhead fitting and finger tighten (see Figure 
8-4). Then, using a 7/16" wrench, tighten the plug 3/4 of a 
turn.

Figure 8-4  Plug sealing the Solid Sample Cartridge bulkhead fitting

3. Insert the Liquid Inject accessory into the lower sample 
injection port. Turn the valve on the Liquid Inject 
accessory so that it is perpendicular to the tubing (closed).

After installing the accessory, the Companion XL is ready for 
liquid injections. To perform a run using a liquid injection:

1. Select “Liquid” as the Sample type from PeakTrak’s Main 
window (Figure 8-5).
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Figure 8-5  Sample Type set for Liquid on PeakTrak’s Main window

2. When all settings have been configured, click the Play 
button to start the run. After column equilibration, the 
system pauses for the liquid injection (Figure 8-6). 

3. Inject the Liquid Sample:

a. Connect a syringe containing the compound mixture to 
the Liquid Injection accessory’s luer fitting. This fitting 
is located above the valve (Figure 8-7). 

b. Open the valve by turning the handle so it is in line with 
the tubing (Figure 8-7). 

c. Inject the liquid compound mixture. 

d. Close the valve by turning the handle so that it is 
perpendicular to the tubing. Remove the syringe. 
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Figure 8-6  Inject Sample display

Note
Chase solvent clears the Liquid Injection accessory tubing and 
forces the liquid compound mixture onto the column. Without the 
chase solvent, some of the sample will remain in the tubing and 
will not be separated. This small amount of sample may also 
cross-contaminate the next purification run. 

The chase solvent should be strong enough to prevent the 
sample from precipitating (or crashing), but not so strong as to 
adversely affect the separation of compounds. Often, the initial 
liquid phase solvent is a practical chase solvent. 

4. Inject a chase solvent:

a. Connect a syringe loaded with a chase solvent to the 
Liquid Injection accessory’s luer fitting. 

b. Open the valve by turning the handle so it is in line with 
the tubing (Figure 8-7). 

c. Inject at least 10 mL of the chase solvent. 

d. Close the valve by turning the handle so that it is 
perpendicular to the tubing. Remove the syringe. 

5. Click the OK button to continue the run. 
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Figure 8-7  Syringe connected to the Liquid Injection accessory

See Inset
(below)
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8.4.2  Solid Sample Cartridges

Solid sample cartridges are practical when there is a need to 
introduce a low-solubility sample onto the column. The 
cartridge holds the prepared sample. After equilibration, the 
Companion XL changes the fluid path so that the mobile 
phase passes through the cartridge and onto the column. 

This solid sample should be prepared and loaded according to 
the on-line help topic “Preparing Solid Samples.” 

After loading the prepared media in the cartridge, place a frit 
on top of the media. Then:

1. Insert the plunger on the cartridge cap until it rests 
against the frit. If more length is needed, the cap will slide 
along the plunger shaft if you press the spring-loaded tab. 

2. Align the top of the cartridge with the opening on the cap 
(Figure 8-8). 

3. Press the tab and slide the cap over the top of the cartridge 
(Figure 8-9). 

4. Turn the cap 1/4-turn and release the tab. 

5. Load the solid sample cartridge on the sample injection 
port (Figure 8-10).

Figure 8-8  Inserting the plunger
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Figure 8-9  Fitting the cap on the cartridge

Figure 8-10  Installing the solid sample cartridge 
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8.4.3  Direct Loading a Sample

Direct loading places the sample mixture on the column 
media. If using this technique, remove the column inserted in 
section 8.3 of these instructions. Then, transfer the mixture 
onto the column through the inlet fitting and re-insert the 
column. The sample is typically transferred onto the top of the 
column media using a syringe.

Note
Equilibrating the column will wash away the sample before the 
purification run. When direct loading samples, always set the 
“Sample Load” on PeakTrak’s main window to “Direct” to prevent 
losing the sample during column equilibration. 

8.5  Start a Default Method
With PeakTrak operating and the solvent lines primed, you 
are now ready to perform a run using the default settings. 
These default settings are preset to the most common 
configurations used by chemists, and have been optimized for 
the use of RediSep columns on the Companion XL. The default 
settings will:

• equilibrate the column

• collect all fluid in the fraction collector rack

• differentiate UV and waste fluid and place the fluids in 
separate tubes

• determine a peak based on slope detection or level 
threshold. 

To initiate the run from the PeakTrak Main window:

1. Click on the “New” toolbar button. 

2. Enter a sample name. If you choose not to, PeakTrak will 
enter the date and time for the sample name when you 
start the run.

3. Review the PeakTrak Main window settings. If you desire 
to change any settings, refer to the Editing a Method 
on-line help topic.

4. Verify the Sample Load setting on PeakTrak’s main 
window selects the correct option for the run. 
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• Liquid—Select this option when you will be injecting 
a liquid sample into the injection port. 

• Solid—Select this option when you will be using a 
solid sample cartridge. 

• Direct —This option is useful when a sample is direct 
loaded on the column media. When this option is 
selected, the Companion XL skips the column 
equilibration and proceeds with the purification run. 

5. Click the Play button.

PeakTrak will list the minimum solvent and tube quantities 
necessary for the run. At this time you can also specify which 
tube in the rack to begin with. Ensure that the requirements 
are met, set the first tube, and click OK. 

If the Sample Type was set for Liquid or Solid, the 
Companion XL then equilibrates the column with the initial 
conditions. 

After equilibrating, the system will pause if you selected the 
Liquid option for the Sample Type. This pause waits for you to 
inject the sample. Click OK to continue the run. 

If you selected the Solid option for the Sample Type, the 
system proceeds with the purification after equilibrating the 
column if a cartridge is present. If a cartridge is not present, 
the system will pause for the user to load the cartridge. 

8.6  Operation During the Purification Run
After injecting the sample, the Companion XL delivers the 
first 3 mL of liquid into the first tube, then advances to the 
next tube. This clears the line of eluant held in the drop 
former tube from a previous run.

You may allow Companion XL to proceed with the run while 
monitoring the progress on the PeakTrak Main window. If 
desired, gradient parameters may be modified during the run. 
(See the Real-time Gradient Editing on-line help topic.)

As the run progresses, the absorbance trace is drawn on the 
Gradient Plot area. The separation or purification continues 
until the end of the run defined by the run length setting, 
expressed in Column Volumes.
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CombiFlash® Companion® XL
Installation Guide

Section 9 Maintenance

9.1  Cleaning
For general cleaning of the enclosure, use distilled water with 
a mild detergent. Use isopropyl alcohol for tougher stains. 

On printed areas, such as the rear panel, avoid rubbing 
vigorously or using aggressive solvents like acetone. Each will 
ruin the printed text. 

CAUTION
Do not immerse the instrument in a water bath. The instrument is 
not watertight and this action could damage the internal 
electronics.

9.2  Tubing Inspection

WARNING
Risk of fire or equipment damage. Faulty tubing, fittings, and 
drains may allow organic solvents to pool in unsafe areas, 
creating a potential for dangerous levels of flammable vapors. 

Visually inspect the solvent, waste, and drain tubing monthly. 
The tubing must be free of any damage, kinks, or 
deterioration. Fittings should show no signs of leaks. 

The top shelf drain and Foxy 200 drain should also be 
inspected at this time. These drain holes should be clear of any 
debris. 

Correct any deficiencies before returning the instrument to 
operation. 
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9.3  Troubleshooting

9.3.1  Electrical

1. If your instrument stops working and the front panel 
status LEDs (Power and Ready) are off, check the line cord 
connection.

2. If the line cord is connected properly, check the fuses in the 
power input module located on the Companion XL’s rear 
panel. These are time delay fuses (T-type) and rated 
according to the mains input power voltage: 

• 100 to 129 VAC mains input: 2.0 A fuse

• 215 to 264 VAC mains input: 1.0 A fuse.

Always replace with the same type. 

9.3.2  Inaccessible fuses

WARNING
Risk of electrical shock. Disconnect the electrical power before 
opening the rear panel or otherwise gaining access inside the 
equipment. Only trained service personnel may gain access to 
the interior. 

Upper and Lower Power Supply – The internal power 
supplies are fused. However, these fuses are not serviceable. 
Replace the power supply unit if it fails. 

9.3.3  Internal Battery

WARNING
Risk of electrical shock. Disconnect the electrical power before 
opening the rear panel or otherwise gaining access inside the 
equipment. Only trained service personnel may gain access to 
the interior. 

If the date is wrong on the data graphs generated by the 
Companion XL, it is likely that the internal battery needs 
replacing. This battery is located on the CPU motherboard 
(upper deck). Replace this battery with a 3.0 V Lithium, part 
number CR2032. Dispose of the old battery in accordance with 
federal, state, and local laws. 
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9.4  Flow Cell Cleaning
The Companion XL may alert you that flow cell cleaning is 
recommended. This alert message appears when flow cell light 
path is partially obstructed but the system is still operable. 

Cleaning the flow cell will keep the amount of noise and drift 
on the absorbance trace at a minimum and ensure accurate 
peak detection. 

The flow cell can be cleaned by pumping a solvent through the 
system. Generally, the recommended solvent is the highest 
polarity solvent you have recently used. Therefore, ethyl 
acetate (often solvent B) would be used. See Table 9-4 for 
alternative solvents. Recent synthesis solvents should also be 
considered. 

9.4.1  Quick Flow Cell Cleaning

Quick cleaning is advantageous because very little solvent is 
required and repriming is not necessary. To quick clean the 
system:

1. Remove the column from the system. 

2. With a syringe, inject the selected solvent into the lower 
column mount.

3. Insert a bypass tube in place of the column.

4. From the PeakTrak menu select the Tools>Manual 
Control… command and pump 100 mL of Solvent A at 100 
mL/min.

5. Replace the bypass tube with a column and start a run. 
The Companion XL will attempt to calibrate the flow cell.

If the calibration is successful, the system is ready for use.

If the alert message persists, refer to the thorough flow cell 
cleaning solvents and techniques. 

9.4.2  Thorough Flow Cell Cleaning

To thoroughly clean the flow cell:

1. Remove the column from the system and insert a bypass 
tube.

2. If using an alternative solvent, place the solvent inlet line 
into a container of the selected solvent. 
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Table 9-1 Suggested Flow Cell Cleaning Solventsa

a. Always handle solvents in accordance with the manufacturer’s or
supplier’s MSDS.

Solvent Description

Methanol Miscible with most LC solvents. It will force other 
solvents through the system so that they will not 
interfere with the next sample. Breaks down the 
tertiary structure of silica and allows it to flush 
through.

Acetone Common organic solvent with high dissolving 
properties.

Dichloromethane 
(DCM)

Effective at solubilizing organic molecules.

Dimethylsulfoxide 
(DMSO)

Strong solvent that will clear organic sample.

Dimethylformamide 
(DMF)

Strong solvent if other solvents do not produce 
the desired results.

Tetrahydrofuran 
(THF)

Strong solvent. 

Mildly acidic 
aqueous solution

0.5M acetic acid in distilled water can be used to 
clear samples that are not removed by organic 
solvents.

Mildly basic 
aqueous solution

A dish-type detergent solution can wash through 
particulates not picked up by the acidic solution. 
The emulsification effect of detergent is an 
effective tool as well to help wash through oily 
samples. Follow the detergent with several 
minutes of clean, distilled water.
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3. Pump 100 ml of solvent through the system at 100 mL/min. 

4. If an alternative solvent was used, return the solvent inlet 
line to the appropriate solvent container. 

5. Select the Tools>Auto Prime menu command to prime the 
system.

6. Replace the bypass tube with a column and start a run. 
The Companion XL will attempt to calibrate the flow cell.

If the calibration is successful, the system is ready for use.

If the alert message persists, refer to the alternative flow 
cell cleaning solvents and techniques. 

The solvent strength and high flow rate will typically clear the 
obstruction and return the flow cell to optimum performance.

9.4.3  Alternative Cleaning Techniques

If the thorough flow cell cleaning instructions do not clear the 
obstruction, the following alternative techniques should be 
considered. 

• Pump water/DMF/methanol (50/25/25) for 3–4 minutes 
followed by pumping straight methanol (or ethanol) for 
2–3 minutes.

• Pump 5–10 mL DMSO followed by methanol, ethyl 
acetate, then hexane.

• After the lines have been filled with solvent, reduce the 
flow rate or pause up to 18 hours. Doing so will allow the 
solvent to remain longer to dissolve the obstruction.
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Companion Hazmat Table    60-5233-405   Rev.  

Name and amount of Hazardous Substances or Elements in the product      

Component Name Hazardous Substances or Elements 

(Pb) (Hg) (Cd) (Cr(VI)) (PBB) (PBDE)

Circuit Boards 
X O O O O O 

O O O O X O 

O O O O X O 

O O O O X O 

X O O O X O 

O O X O O O 

O O O O X O 

Name and amount of Hazardous Substances or Elements in the product 

O: ST/

O: Represent the concentration of the hazardous substance in this component’s any homogeneous pieces is lower than the 
ST/ standard limitation. 

X ST/ 

( “X” )

X: Represent the concentration of the hazardous substance in this component’s at least one homogeneous piece is higher 
than the ST/ standard limitation. 

(Manufacturer may give technical reasons to the “X”marks) 

The Environmentally Friendly Use Period (EFUP) was determined through experience. 

(207 2007 ) A

B

The date of Manufacture is in code within the serial number.  The first three numbers are the year of manufacture (207 is 
year 2007) followed by a letter for the month. "A" is January, "B" is February and so on. 





Companion with Touchscreen Hazmat Table    60-5233-406   Rev.  

Name and amount of Hazardous Substances or Elements in the product 

Hazardous Substances or Elements 

Component Name 
(Pb) (Hg) (Cd) (Cr(VI)) (PBB) (PBDE)

LCD Display 
O X O O O O 

Circuit boards 
X O O O O O 

Wiring
O O O O X O 

Internal Cables 
O O O O X O 

Line Cord 
O O O O X O 

Stepper Motor 
X O O O X O 

Deuterium lamp 
O O X O O O 

Valve Body 
O O O O X O 

Name and amount of Hazardous Substances or Elements in the product 

O: ST/

O: Represent the concentration of the hazardous substance in this component’s any homogeneous pieces is lower than the 
ST/ standard limitation. 

X ST/ 

( “X” )

X: Represent the concentration of the hazardous substance in this component’s at least one homogeneous piece is higher 
than the ST/ standard limitation. 

(Manufacturer may give technical reasons to the “X”marks) 

The Environmentally Friendly Use Period (EFUP) was determined through experience. 

(207 2007 ) A

B

The date of Manufacture is in code within the serial number.  The first three numbers are the year of manufacture (207 is 
year 2007) followed by a letter for the month. "A" is January, "B" is February and so on. 





DECLARATION OF CONFORMITY

 

Application of Council Directive: 89/336/EEC – The EMC Directive 
73/23/EEC – The Low Voltage Directive 

Manufacturer's Name: Teledyne Isco, Inc. 

Manufacturer's Address: 4700 Superior, Lincoln, Nebraska 68504 USA 
Mailing Address: P.O. Box 82531, Lincoln, NE 68501 

Equipment Type/Environment: Laboratory Equipment for Light Industrial/Commercial Environments 

Trade Name/Model No: CombiFlash Companion XL with Touch screen and Foxy 200 

Year of Issue: 2004 

Standards to which Conformity is Declared: EN 61010-1    Safety Requirements for Electrical Equipment for                      
Measurement, Control, and Laboratory Use  

EN 61326:1998 EMC Requirements for Electrical Equipment for    
Measurement, Control, and Laboratory Use 

    

Standard Description Severity Applied Performance Criteria 

EN61000-4-2 Electrostatic Discharge Level 2 - 4kV contact discharge 
Level 3 - 8kV air discharge 

A

EN61000-4-3 Radiated RF Immunity 80 MHz to 1000MHz 80% AM at 1kHz 
Level 2 - 3V/m 

A

EN61000-4-4 Electrical Fast Transient Level 2 - 1kV on AC lines                              A 

EN61000-4-5 Surge on AC Lines Level 2 - 1kV common mode,                       
Level 2 - 0.5KV differential mode 

A

EN61000-4-6 Conducted RF on AC lines 150 kHz to 80 MHz,                                
Level 1 - 1V rms, 80% modulated 

A

EN61000-4-11 Voltage Dips/Short Interruptions 100% drop, 10ms A 

CISPR11/
EN 55011 

RF Emissions Group 1, Class A Industrial, Scientific, and 
Medical Equipment 

EN61000-3-2, 3-3 Harmonic and Flicker  

     
We, the undersigned, hereby declare that the design of the equipment specified above conforms to the above Directive(s) and 
Standards as of October 10, 2004.

Bill Foster 
USA Representative 

T e le dy n e  I s c o  I n c .

Bill Foster 
Director of Engineering 
Teledyne Isco, Inc. 
4700 Superior Street 
Lincoln, Nebraska 68504 

Phone: (402) 464-0231 
Fax: (402) 464-4543 

60-5242-008 
Rev  A

  





Teledyne Isco One Year Limited Warranty* 
Factory Service for Teledyne Isco CombiFlash®  Systems 

This warranty exclusively covers Teledyne Isco 
CombiFlash® instruments, providing a one-year limited 
warranty covering parts and labor. 

the customer will pay to return the instrument to Teledyne 
Isco, and Teledyne Isco will pay surface transportation to 
return the repaired instrument to the customer. Teledyne 
Isco will not pay air freight or customer’s packing and 
crating charges. This warranty does not cover loss, damage, 
or defects resulting from transportation between the 
customer’s facility and the repair facility. 

Any instrument that fails during the warranty period due to 
faulty parts or workmanship will be repaired at the factory at 
no charge to the customer. Teledyne Isco’s exclusive 
liability is limited to repair or replacement of defective 
instruments. Teledyne Isco is not liable for consequential 
damages.

The warranty for any instrument is the one in effect on date 
of shipment. The warranty period begins on the shipping 
date, unless Teledyne Isco agrees in writing to a different 
date.CombiFlash systems are designed to use Teledyne Isco 

RediSep columns. RediSep columns lead the industry in 
quality and performance.  Customers may use other brands 
of columns on their CombiFlash instruments. These non-
RediSep columns may fail to separate compounds, may leak 
silica into the flow path of the CombiFlash instrument, and 
may leak solvents from their fittings and seals.  

Excluded from this warranty are normal wear; expendable 
items such as charts, ribbon, lamps, tubing, and glassware; 
fittings and wetted parts of valves; and damage due to 
corrosion, misuse, accident, or lack of proper maintenance. 
This warranty does not cover products not sold under the 
Teledyne Isco trademark or for which any other warranty is 
specifically stated.   Damage to CombiFlash instruments resulting from the 

failure of a non-RediSep column may cause the need for 
repairs that incur billable service activities. The customer is 
responsible for these charges. 

This warranty is expressly in lieu of all other warranties 
and obligations and Teledyne Isco specifically disclaims 
any warranty of merchantability or fitness for a 
particular purpose. Teledyne Isco will pay surface transportation charges both 

ways within the 48 contiguous United States if the 
instrument proves to be defective within 30 days of 
shipment. Throughout the remainder of the warranty  period, 

The warrantor is Teledyne Isco, Inc. 4700 Superior, Lincoln, 
NE 68504, U.S.A. 

* This warranty applies to the USA and countries where Teledyne Isco Inc. does not have an authorized dealer. Customers in countries 
outside the USA, where Teledyne Isco has an authorized dealer, should contact their Teledyne Isco dealer for warranty service. 

Before returning any instrument for repair, please call, fax, or e-mail the Teledyne Isco Service 
Department for instructions. Many problems can often be diagnosed and corrected over the 
phone, or by e-mail, without returning the instrument to the factory. 

Instruments needing factory repair should be packed carefully, preferably in the original carton, 
and shipped to the attention of the service department. Small, non-fragile items can be sent by 
insured parcel post. PLEASE BE SURE TO ENCLOSE A NOTE EXPLAINING THE DEFECT.

 Shipping Address: Teledyne Isco, Inc. - Attention Repair Service 
4700 Superior Street 
Lincoln NE 68504 USA 

Mailing address: Teledyne Isco, Inc. 
PO Box 82531 
Lincoln NE 68501 USA 

Phone: Repair service:  (800)775-2965 (lab instruments)

 (800)228-4373 (samplers & flow meters) 

Sales & General Information (800)228-4373 (USA & Canada)

 Fax: (402) 465-3001 

 Email: iscoservice@teledyne.com   Web site:   www.isco.com 

February 1, 2006  P/N 60-2132-281 Rev C 
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